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Introduction
Exostiv Dashboard
This guide provides instructions on how to use the EXOSTIV Dashboard software to extract and visualize debug trace
data from FPGA.
For instructions about how to install EXOSTIV Dashboard, refer to Appendix A – EXOSTIV Dashboard Installation Notes.

EXOSTIV Dashboard: Main controls

: Connect to EXOSTIV
: EXOSTIV

Probe

Core Inserter: use to configure and insert EXOSTIV Probe.

: EXOSTIV Analyzer: use to capture and analyze data from instrumented design

EXOSTIV Dashboard – Welcome screen
From there, you can create or open a project, access the documentation and manage your software license.
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EXOSTIV Dashboard: Menus
FILE Menu:

Please refer to ‘Project Archive Manager’ below.

Tools Menu:

Please refer to Appendix A – EXOSTIV Dashboard
Installation Notes below.
Please refer to Options: interface and project options
below

Help Menu:

Use to manage license and license keys
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Options: interface and project options
This menu item opens the ‘Options’ dialog that provides general interface and project options.
Option
Description
Vivado
Applies to EXOSTIV for Xilinx in ‘netlist flow’.
➔ Vivado Link Timeout
Sets up the timeout for the ‘Vivado Link’. When Vivado
fails to react to a command from EXOSTIV Dashboard
after the specified timeout, a dialog opens, prompting
for cancelling the command or waiting longer.
Capture Units Definition
Sets up the dialog boxes used for confirming actions.
EXOSTIV IP Insertion
On Application Close
HDMI Cable Setup
Select to enable output power line on the HDMI cable.
➔ Enable HDMI output power
Please refer to ‘UG102 - EP Series Connecting Guide’ to
know more about supplying power from the probe onto
the HDMI cable.
Miscellanous Settings
➔ Digit grouping
Defines the digit / comma separators for numbers in the
interface

Rev. 1.0.13- June 29, 2021
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Project Archive Manager

The ‘Project Archive Manager’ helps managing, saving and recalling project configurations.
Each generated EXOSTIV IP core has got an ‘Universal Unique Identification’ (‘Uuid’) that enables EXOSTIV Dashboard
identify an IP once it is inserted inside the target FPGA and check if the settings used in the Dashboard matches it.
For instance, EXOSTIV Dashboard must make sure that the capture unit settings match these of the loaded IP before
it is able to capture data and properly process it.
If the UUID of the EXOSTIV IP loaded in the target FPGA does not match the project’s UUID, EXOSTIV Dashboard will
refuse to establish a connection with the EXOSTIV IP and won’t be able to extract data from the target FPGA.
This ID is defined automatically when the IP is generated.
The Project Archive Manage enables archiving, restoring and deleting project settings. When connecting to an FPGA,
it tries to suggest the valid configuration available in the archive that matches the UUID that is readback from the
target instrumented FPGA. It does NOT save and archive the FPGA programming files (bit, bin, sof) generated with the
FPGA vendor tool after implementation, which should be managed separately.

Rev. 1.0.13- June 29, 2021
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Exostiv flows
EXOSTIV provides 2 user flows – which differ in how the EXOSTIV IP is inserted
1. RTL flow (available from EXOSTIV Dashboard v. 1.5.4):
In this type of flow, EXOSTIV IP is configured with EXOSTIV Dashboard and provided to the user as a netlist
with a component / module top-level in Verilog or VHDL, together with constraint files. The insertion into
the target design is done at RTL level by the user.
2.

Netlist flow:
In this type of flow, EXOSTIV IP is configured with EXOSTIV Dashboard and inserted into the target design
after synthesis. EXOSTIV IP is not provided as a separate set of files, but directly integrated into the target
design netlist by connecting a list of selected nodes to it.

The figure below provides an overview of the alternative EXOSTIV flows. Table # sums up the differences between each
flow.

Exostiv for Xilinx
Exostiv for Intel (Altera)
Insertion level
Output

Remaining steps after
EXOSTIV Core Inserter
has run

Level of EXOSTIV IP
configuration
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RTL flow
Available
Available
RTL (VHDL, Verilog)
Synthesized EXOSTIV IP with RTL (VHDL or
Verilog) wrapper ready to be inserted with
constraints.
Manual insertion into target HDL
code.
Synthesis of instrumented design.
Implementation of instrumented
design.
FPGA configuration file generation.
FPGA programming with FPGA
vendor configuration file (bin, bit,
sof, …)
The output EXOSTIV IP is set up as a generic IP
ready to be inserted into the RTL code of the
target design. The connection of the EXOSTIV
IP with the internal nodes from the target
design is manual. EXOSTIV IP top level provides
a specified number of inputs ready to be
connected.

Netlist flow
Available
NOT available
Please contact us for roadmaps.
Netlist – after synthesis
Synthesized & implemented target design including
the EXOSTIV IP. Comes with the required constraints.
-

-

Implementation of instrumented design
(can be run from EXOSTIV Dashboard
automatically)
Binary file generation.
FPGA programming with bin file.

EXOSTIV IP is configured and inserted into the target
design netlist by using a set of queries sent to the
FPGA vendor tool. The nodes that need to be
connected to EXOSTIV IP are selected from the target
design directly parsed from EXOSTIV Dashboard
(using the FPGA vendor tool). After synthesis,
EXOSTIV IP is inserted into the target design netlist

9

and automatically connected to the specified nodes
from the target design.

The user must select the desired IP insertion flow at startup, when creating a new project with EXOSTIV Dashboard.
•
EXOSTIV for Xilinx:
Netlist IP Insertion and RTL IP Insertion choices are available
•
EXOSTIV for Intel:
Only RTL IP Insertion is available.

Rev. 1.0.13- June 29, 2021
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Chapter 1: Core Inserter
Locate & Start Core Inserter
The Core Inserter opens when creating a new project and when clicking on the Core Inserter icon in the toolbar:
From the menu: File > New Project:

-

From the Welcome screen:

-

From the toolbar: Core Inserter icon

Rev. 1.0.13- June 29, 2021
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Core Inserter - Overview
The Core Inserter is made of multiple screens to be used sequentially. This sequential flow is summarized in the top
area of the Core Inserter. Clicking in each of the flow steps switches the Dashboard display to a specific page. The
top flow bar depends on the chosen EXOSTIV Core Inserter flow (RTL flow or netlist flow).

Flow bar in ‘Netlist Flow’

Core Inserter flow : this chapter
-

Analyzer : refer to Chapter 2.

Link Configuration
Capture Configuration
Run Insertion – or – Generate EXOSTIV IP
Flow bar in ‘RTL flow’

Schematically, the following steps must be followed to set up and insert EXOSTIV IP (‘Core’) in a target design:
1)

Link Configuration: sets up the link between EXOSTIV IP and EXOSTIV Probe.
This step is used to define the parameters of the physical link between the target FPGA and EXOSTIV Probe:
transceivers parameters, pin locations, type of interface, data rates and so on.

2)

Capture Configuration: sets up the capture inside the target FPGA.
This step is used to set up EXOSTIV IP’s connections with the internal logic of the target FPGA. It also defines
the resources reserved for the IP to sample data, define triggering and filtering events and locally store trace
data.
If the ‘Netlist IP Insertion flow’ is used, a connection with the FPGA vendor design tool is required (currently
only applies to EXOSTIV for Xilinx FPGA).
If the ’RTL IP Insertion flow’ is used, this steps is used to define the EXOSTIV IP structure and resources (FIFO
size, trigger unit complexity, number of ports, …)

3)

Insert EXOSTIV IP (Netlist flow): synthesizes EXOSTIV IP, inserts it into target design and run
instrumented design implementation.
During this step, EXOSTIV Core Inserter calls the FPGA vendor tool to synthesize EXOSTIV IP, insert it into the
target FPGA and connect it to the target FPGA nodes chosen at step 2) and run the implementation of the
target design instrumented with EXOSTIV IP.

Generate EXOSTIV IP (RTL flow): synthesizes EXOSTIV IP.
During this step, EXOSTIV Core Inserter calls the FPGA vendor tool to synthesize EXOSTIV IP, generate a HDL
(VHDL or Verilog) top-level file and constraint files. These files must be used to instrument the target design
RTL source code: EXOSTIV IP should then be instantiated into the target code and the instrumented design
should be synthesized and implemented with the FPGA vendor tool.

Once the full core inserter flow is over, the target FPGA can be programmed with the generated programming files
(the programming files format depends on the chosen FPGA vendor). Thereafter, EXOSTIV Analyzer can be used to
capture data (refer to Chapter 2: Analyzer).
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Core Inserter – Linking to FPGA vendor tool in ‘Netlist flow’
(This section only applies to ‘Netlist flow Insertion’ – currently only available for Xilinx FPGA.)

Some of the Core Inserter functionalities - such as selecting the IP connections to the target
FPGA nodes or selecting the sampling clock of a capture unit – work based on queries sent by
EXOSTIV Dashboard to the FPGA Vendor tool (Xilinx Vivado).
This link is used in ‘Netlist flow’ only.
To use these features, a link must be established between EXOSTIV Dashboard and the FPGA
Vendor tool.
To establish a link between EXOSTIV Dashboard and Vivado, please proceed as follows:
1. Open Vivado and open the project containing the target FPGA design:

2. From the flow navigator in Vivado, open synthesized design:

If the design was not synthesized, you’ll have to synthesize it.
3. Click on the ‘Open EXOSTIV Dashboard’ icon in the toolbar.
This shortcut is installed with EXOSTIV Dashboard.
Can’t find it? Refer to Appendix A – EXOSTIV Dashboard Installation Notes

If you cannot find it, you can install it from the EXOSTIV Dashboard menu:
Tools > Install Dashboard Shortcut
You’ll have to shut down Vivado and restart from 1.
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4. After clicking on the shortcut, the following window appears, listing the instances
of EXOSTIV Dashboard currently running:

5. Select the desired instance and click on ‘Link to Vivado’.
6. Switch back to the EXOSTIV Dashboard. You are now connected to Vivado with
EXOSTIV Dashboard.

Rev. 1.0.13- June 29, 2021
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Core Inserter – Link Configuration
Link Configuration: locate and access
-

Click on the ‘Link Configuration’ button of the top bar of the Core Inserter.

Click here

Link Configuration: overview
The ‘Link Configuration window’ is used to configure the interface between EXOSTIV IP and EXOSTIV Probe. It sets up
the transceivers. Please refer to UG401 – EXOSITV IP user’s guide for a detailed description of the IP’s parameters.

Link Configuration: parameters

Rev. 1.0.13- June 29, 2021
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Table 1: Link Configuration parameters

Rev. 1.0.13- June 29, 2021

16

Control group

Description

FPGA Type

Use these controls to define the target FPGA family, device,
speed grade and package.

Connector

Choose the connector that will be used on the EXOSTIV Probe.
Either HDMI or SFP can be selected. Please refer to ‘UG201 :
Interfacing EXOSTIV Probe EP Series’ Series for more details
about the physical connection with EXOSTIV Probe.

Upstream link

Use these controls to set up the ‘Upstream link’ – that is the
link between EXOSTIV IP and EXOSTIV Probe. This link uses
from 1 to 4 transceivers. The transceivers are designated from
their I/O bank on the FPGA and the I/O site of their ‘P’
channel. Please refer to the chosen FPGA pinout and its
connections on the target board.

Upstream link transceivers choice grouped
by 4 (Quad, Xilinx FPGA)

At IP insertion, there is no restriction on the number of
transceivers. EXOSTIV Probes have from 1 to 4 usable
transceivers, depending on the chosen option. Please make
sure to generate an EXOSTIV IP that can be used with your
EXOSTIV Probe.
Transceiver bank: select the I/O bank of the target FPGA that
is reserved for use with EXOSTIV
MGT_TxP# : click on the corresponding tick box to use this
transceiver in EXOSTIV IP. The I/O site for the P pin is derived
from the ‘transceiver bank’ choice above.

Upstream link transceivers choice grouped
by 6 (transceivers banks, Intel FPGA)

Rev. 1.0.13- June 29, 2021
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Downstream link

As described in UG401 – EXOSTIV IP user’s guide, EXOSTIV IP
implements a downstream link that is used to control the IP
during analysis (e.g.: to change the trigger condition at
runtime.).
This downstream link is implemented differently when using
the HDMI or the SFP type of connector:
With the HDMI type, 2 extra pins are
needed on the FPGA package for a
downstream link using a protocol
similar to I2C.
Once the HDMI type is selected, the
location and I/O standard of these pins
must be specified.
-

With the SFP type, the downstream
link is implemented with the link itself.
Once the SFP type is selected, the
location of the downstream link
transceiver must be specified.

Please refer to UG201 : Interfacing EXOSTIV Probe EP Series
for a detailed description of the pin allocation and the
required physical connections.
Reference clock

This group of control sets up the transceivers’ reference clock.
The chosen clock depends on the board design.
Specify the location it is taken from and the clock frequency.
Based on the specified frequency, the desired data rate (line
rate) can be derived.
The ‘EXOSTIV clock output’ tick box allows mirroring the
EXOSTIV Probe’s clock at its output clock port.

Core Inserter – Capture Configuration
Capture Configuration: locate and access

Click here

Capture Configuration: overview
The ‘Capture Configuration window’ is used to set up the EXOSTIV IP’s ‘capture’ logic.
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It is used to:
Define the nodes from the target FPGA that will be sampled and observed;
Define the resources allocated to the EXOSTIV IP to detect a trigger condition, sample data from the target FPGA
and to send it outside the FPGA to EXOSTIV Probe.

Capture Configuration: adding & configuring Capture Units
A ‘Capture Unit’ is the logic unit added to the EXOSTIV IP, that takes care about sampling data from the target FPGA
and sending it to the EXOSTIV Probe.
Each Capture Unit:
is connected to 1 to 16 ‘Data Group(s)’.
The Data Groups are multiplexed and the user can switch from one data group to another during analysis without
having to recompile the EXOSTIV IP. Each Data Group can be connected to up to 2,048 FPGA internal logic nodes.
-

uses 1 single clock for sampling data.
This clock is chosen among the clocks available internally in the target FPGA. If EXOSTIV has to collect data from
more than one clock domain, a separate capture unit has to be defined for each clock domain.
Adversely, multiple capture units can use the same reference clock for sampling data.

-

includes logic for triggering and data qualification.
This logic is used to detect the conditions for starting a capture and for filtering the data.

-

includes one FIFO, that is used for buffering data before sending to the transceivers. This FIFO is implemented
by using blocks of memory from the target FPGA fabric.

Rev. 1.0.13- June 29, 2021
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To add or remove capture units and/or data groups:

Double click here to add a data group for
Capture Unit 1
Double click here to add a capture unit

Rev. 1.0.13- June 29, 2021

Hover on the Capture Unit or the Data
Group and click on the ‘X’ to remove
it. Removing a capture unit also
removes the data groups of this
capture unit.
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To set up a capture unit or a data group:
Click on the capture unit or the data group that you wish to set up. The Dashboard controls
switch to the selected element’s settings page.
‘Netlist Flow’

Capture Unit 1 settings

Select & click on Capture Unit

Data Group ‘Video-HD-SDI’ settings

Select & click on Data Group

‘RTL Flow’

Rev. 1.0.13- June 29, 2021
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Capture Unit parameters in ‘Netlist flow’
(This section only applies to ‘Netlist flow Insertion’ – currently only available for Xilinx FPGA.)
Table 2: Capture Unit parameters
Control group

Description

Triggering

Defines the trigger settings for the selected capture unit.
Trigger unit type: use this drop-down list to
select between ‘Levels / Edges / Comparisons’
or ‘Levels / Edges’ only.
This setting sets the complexity of the trigger
unit by enabling / disabling ‘comparison
operators’. ‘Levels / Edges / Comparisons’
requires more FPGA resources.
The available operations are summarized under
the drop-down control.
Counter width: specifies the width of the events
counter (will be available in a future version of
the Dashboard).
Sequencer depth: specifies the depth of the
sequential counter state machine (will be
available in a future version of the Dashboard).
Storage qualification: use this tick box to
enable/disable storage qualification for the
selected capture unit.
‘Storage qualification’ allows defining logic
conditions on the capture unit inputs in order to
filter the incoming data for capture.
Number of pipes: defines the number of
pipelining stages placed in each of the data
groups paths before the capture unit’s
multiplexer.

Data

Sets up the Capture Unit FIFO and summarizes the capture
unit’s size
Fifo depth: specifies the capture unit’s FIFO
depth. Selectable values: 1024 to 8192.
Number of data groups (informative only)
shows the number of data groups defined for
this capture unit.
Number of data probes (informative only)
shows the width of the capture unit in bits. This
value is the width of the largest data group
connected to the capture unit. It also defines
the FIFO width.

Sampling clock

Defines the reference clock from the target FPGA design
used to sample data with the selected capture unit.
If data from more than one clock domain must
be sampled, a separate capture unit for each
clock domain should be defined.
To select this clock from the design loaded in
Vivado, link dashboard to Vivado first. Then
click on
. Refer to ‘How to select capture
unit clocks and data groups signals’ below.
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Data Group parameters in ‘Netlist flow’
(This section only applies to ‘Netlist flow Insertion’ – currently only available for Xilinx FPGA.)

Each signal connected to the selected data group can be defined as ‘Data only’ or ‘Data and
Trigger’ with 2 tick boxes. When defined as ‘trigger’, this signal can be used to define trigger
condition during analysis. Unselecting the ‘trigger’ option for a signal helps reduce the logic
resources required for implementing EXOSTIV IP.
How to select capture unit clocks and data groups signals?
Defining the Capture Unit’s sampling clock and selecting the signals (nodes) connected to a data
group requires browsing the target FPGA design. To do this, EXOSTIV Dashboard establishes a
link with the FPGA vendor tool (Vivado for Xilinx FPGAs) and sends queries to it.
Please refer to ‘Core Inserter – Linking to FPGA vendor tool’ to know how to establish this link.
To select the Capture Unit’s sampling clock:
1. Select the desired Capture Unit from the left column.
2. Click on
in the ‘Sampling Clock’ controls group. It opens the ‘Connect
Probes’ window, from which you can browse the target FPGA design and select the
desired clock signal. Click on ‘Done’.

Browse design

List clock signals

Rev. 1.0.13- June 29, 2021
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To select a Data Group’s signals:
1. Select the desired Data Group from the left hand column
2. Click on ‘Edit Probes’

3. In the ‘Connect Probes’ window, the design loaded in Vivado can be browsed and
its internal nodes / signals are listed. Use the window controls to select the signals
you wish to insert in the selected Data Group from the selected Capture Unit. Click
on ‘Done’ once you’re finished.

Browse design

List signals
Selected signals

Rev. 1.0.13- June 29, 2021
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Note:

The sampling clock and the signals connected to a capture unit should be chosen as part of the same clock
domain. If a clock is selected and the chosen signals of a data group are not in the corresponding clock domain,
it will result a longer implementation of the EXOSTIV IP in the target design – and likely – a timing error.
EXOSTIV Dashboard future releases will include an automatic clock selection from data group signals to
facilitate the definition and setup of data groups.

Capture Unit parameters in ‘RTL flow’
Control group

Description

Triggering

Defines the trigger settings for the selected capture unit.
Trigger unit type: use this drop-down list to
select between ‘Levels / Edges / Comparisons’
or ‘Levels / Edges’ only.
This setting sets the complexity of the trigger
unit by enabling / disabling ‘comparison
operators’. ‘Levels / Edges / Comparisons’
requires more FPGA resources.
The available operations are summarized under
the drop-down control.
Counter width: specifies the width of the events
counter (will be available in a future version of
the Dashboard).
Sequencer depth: specifies the depth of the
sequential counter state machine (will be
available in a future version of the Dashboard).
Storage qualification: use this tick box to
enable/disable storage qualification for the
selected capture unit.
‘Storage qualification’ allows defining logic
conditions on the capture unit inputs in order to
filter the incoming data for capture.
Number of pipes: defines the number of
pipelining stages placed in each of the data
groups paths before the capture unit’s
multiplexer.

Data

Sets up the Capture Unit FIFO and summarizes the capture
unit’s size
Fifo depth: specifies the capture unit’s FIFO
depth. Selectable values: 1024 to 8192.
Number of data groups: specifies the the
number of data groups defined for this capture
unit.
Number of data probes: specifies the width of
the capture unit in bits. This value is the width
of the data groups connected to the capture
unit. It also defines the FIFO width.
Number of data only probes: select the tick box
to activate the control. It specifies the number
of nodes (‘data probes’) connected to the
capture unit that should be used as ‘data only’.
In such a case, the IP will feature the specified
number of inputs that won’t be connected to
the capture unit logic for triggering. This option
helps saving on the capture unit logic resources
when the trigger does not have to be sensitive
to all the capture unit’s inputs.
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Data Group parameters in ‘RTL flow’
There are no additional parameters for the data groups. The target design nodes are selected
by instantiating the IP in the RTL code. Selecting a data group displays the following message,
reminding of the specified total width (number of nodes that can be connected) of the data
group.
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Core Inserter – Insert EXOSTIV IP (Netlist flow)
(Only applies to ‘netlist flow’, available from EXOSTIV for Xilinx)

Insert EXOSTIV IP: locate and access

Click here

Insert EXOSTIV IP: overview
The ‘Run Insertion window’ is used to start the insertion of EXOSTIV IP in the target FPGA design.
For that purpose, there has to be a link with the FPGA vendor tool (Vivado). To link EXOSTIV Dashboard to Vivado,
please refer Core Inserter – Linking to FPGA vendor tool.
The ‘Run Insertion window’ controls are summarized below:

Click here to start the EXOSTIV IP insertion process

Path to
folder

Vivado

installation

EXOSTIV IP instance name

IP cache controls

Flow progress bars
Optional: start implementation and bitstream
generation after synthesis (recommended). Specify
the implementation name.
If not selected, the implementation and bitstream
generation will need to be started manually from
Vivado.
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Schematically, when hitting the ‘Insert EXOSTIV IP’, EXOSTIV Core Inserter will:
1. Synthesize the EXOSTIV IP
2. Insert the EXOSTIV IP into the target FPGA design loaded in Vivado
3. Run the chosen implementation (if selected)
4. Generate the bitstream (if selected).
Note: Before starting the insertion, it is required (and proposed with a pop-up window) to save the project file. This
step is mandatory to make sure that the project file contains and matches the unique ID of the EXOSTIV IP that is
generated. This ID is used during analysis to connect the EXOSTIV Probe the EXOSTIV IP and to check its features.

Insert EXOSTIV IP: details about the flow
In this section, we provide more details about each step of the EXOSTIV IP insertion flow.
Checking configuration
Starting Vivado Shell
Creating debug core project
Configuring debug core
Generating memories
Synthesizing debug core
Inserting debug core
Connecting probes
Generating constraints
Design rules check
Implement design
Generate bitstream
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Checks if the options chosen for EXOSTIV IP are coherent and complete.
Starts a separate Vivado session, that will be used to generate the EXOSTIV IP.
Requires a Vivado license to be properly installed and available.
Creates a separate project in the new Vivado session, that will be used to generate
the EXOSTIV IP.
Generates the source files for the EXOSTIV IP as configured with the EXOSTIV
Dashboard Core Inserter.
Generates EXOSTIV IP’s memories, used in the capture units.
Synthesizes EXOSTIV IP.
Inserts EXOSTIV IP into the target design netlist.
Connects the chosen nodes from the target design to the inserted EXOSTIV IP.
Generates the design constraints related to EXOSTIV IP (timing, …) and adds them
to target design project.
Calls a Vivado DRC (Design Rules Check) on the instrumented synthesized design.
Runs design implementation with Vivado.
Generates programming file with Vivado.
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Core Inserter – Generate EXOSTIV IP (RTL flow)
EXOSTIV for Xilinx – Generate EXOSTIV IP in RTL flow
The ‘Generate EXOSTIV IP’ is available for RTL flow projects only. The ‘Generate EXOSTIV IP’ window and controls are accessible by
clicking on the corresponding button on the flow bar.

Click here to start the EXOSTIV IP generation process

IP cache controls
Path to
folder

EXOSTIV IP output name and output folder
Vivado

installation

Flow progress bars

Figure 1: EXOSTIV for Xilinx – RTL flow – Generate EXOSTIV IP - overview
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EXOSTIV for Intel – Generate EXOSTIV IP in RTL flow

Click here to start the EXOSTIV IP generation process

IP cache controls

EXOSTIV IP output name and output folder

Path to Quartus installation folder

Flow progress bars

Figure 2: EXOSTIV for Intel – RTL flow – Generate EXOSTIV IP - overview

Overview of the files generated with the RTL flow (click here for the online article)
A series of files are generated by the EXOSTIV Dashboard RTL flow IP generation process. These files must be used
with the target FPGA design to instrument the target FPGA and use EXOSTIV to debug the FPGA.
All the files names are prefixed with the EXOSTIV IP instance name specified in the project. Here is the list of generated
files and their usage:

EXOSTIV for Xilinx FPGA
File name
<Instance name>.edf
<Instance name>.vho

<Instance name>.vo

<Instance name>_pinout.xdc

<Instance name>_timing.tcl

Usage
EXOSTIV IP synthesized netlist.
Example template on how to
instantiate the EXOSTIV IP in the
target design in VHDL.
Example template on how to
instantiate the EXOSTIV IP in the
target design in Verilog.
Constraint file containing the pinout
required by the EXOSTIV IP (like
transceiver location).

Constraint file containing the timing
constraints relative to EXOSTIV IP.

Add to Vivado project?
YES
NO this is an example
template.
NO this is an example
template.
NO. This file must be ‘sourced’
between synthesis and
implementation.
Command: source -notrace
<tcl file>
NO. This file must be ‘sourced’
between synthesis and
implementation.
Command: source -notrace
<tcl file>
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<Instance name>_pkg.vhd

<instance name>_module.v

VHDL Package file containing types
used for the EXOSTIV IP
instantiation.
Verilog module for EXOSTIV IP
netlist

YES, in VHDL flows

YES, in Verilog flows.

Table 3 : EXOSTIV for Xilinx – files generated in RTL flow

EXOSTIV for Intel FPGA
<instance name>_pinout.tcl. Assigns the additional pins required with EXOSTIV IP.
<instance name>_sources.tcl. Adds the required source files to the Quartus project for use with EXOSTIV IP
1) Please open the file <instance name>_sources.tcl with a text editor and follow the instructions about ‘relative
paths’ and .qdb partitioning (qdb partitioning only applies when Quartus Prime PRO is used). The instructions are
enclosed in the comments in these files.
2) Please source the 2 above tcl scripts in your .qsf project file. Please make sure to use relative path when referencing
the scripts:
Add the following lines to the project .qsf file:
>> source <relative_path>/exi_top_pinout.tcl
>> source <relative_path>/exi_top_sources.tcl
– Example:
source “../../test/IP184-4ch/exi_top_pinout.tcl”
source “../../test/IP184-4ch/exi_top_sources.tcl”
An example of .qsf file is also provided (Sample.qsf).
Please find the list of generated files with their description below:
<instance name>.qxp : EXOSTIV IP synthesized netlist.
<instance name>_wrapper.vhd : EXOSTIV IP top level wrapper. This module must be instantiated in the target design.
<instance name>_wrapper.vho : Example template on how to create a VHDL instance of EXOSTIV IP in the target
design.
<instance name>_wrapper.vo : Example template on how to create a Verilog instance of EXOSTIV IP in the target
design.
<instance name>_pinout.tcl : Script containing the pinout constraints required by the EXOSTIV IP
<instance name>_timing.sdc : Constraint file with the timing constraints of EXOSTIV IP.
<instance name>_wrapper_pkg.vhd : VHDL package containing the types used for the EXOSTIV IP instantiation.
<instance name>_wrapper_module.v : Verilog module for EXOSTIV IP netlist.
<instance name>.vhd : VHDL entity for EXOTIV IP netlist
sample.qsf : Example of required TCL commands to insert at the end of QSF file, to add the Exostiv IP to the Quartus
project.
exi_sync_reset.vhd : Internal source file for EXOSTIV IP.
exi_xcvr_startup_clock.vhd : Internal source file for EXOSTIV IP.
exi_xcvr_top.vhd : Internal source file for EXOSTIV IP.
For Quartus Standard Edition:
<instance name>.qxp : EXOSTIV IP synthesized netlist.
exi_refclk_div.qsys : Internal file for EXOSTIV IP.
exi_xcvr_fpll.qsys : Internal file for EXOSTIV IP.
exi_xcvr_atxpll.qsys : Internal file for EXOSTIV IP.
exi_xcvr_rst.qsys : Internal file for EXOSTIV IP.
exi_xcvr_rx.qsys : Internal file for EXOSTIV IP.
exi_xcvr_tx.qsys : Internal file for EXOSTIV IP.
For Quartus Pro Edition:
<instance name>.qdb : EXOSTIV IP synthesized netlist.
exi_refclk_div.ip : Internal file for EXOSTIV IP.
exi_xcvr_fpll.ip : Internal file for EXOSTIV IP.
exi_xcvr_atxpll.ip : Internal file for EXOSTIV IP.
exi_xcvr_rst.ip : Internal file for EXOSTIV IP.
exi_xcvr_rx.ip : Internal file for EXOSTIV IP.
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exi_xcvr_tx.ip : Internal file for EXOSTIV IP.

For Exostiv Dashboard software version 1.8.3 and older:
File name
<Instance name>.qxp
<Instance name>_wrapper.vhd
<instance name>_wrapper.vho
<Instance name>_pinout.tcl

<Instance name>_timing.sdc
<Instance
name>_wrapper_pkg.vhd
xcvr_rx.qsys
xcvr_tx.qsys

Usage
EXOSTIV IP synthesized netlist.
EXOSTIV IP top level wrapper. This module
must be instantiated in the target design.
Example template on how to instantiate the
EXOSTIV IP in the target design.
Script containing the pinout constraints
required by the EXOSTIV IP (like transceiver
location).
Constraint file containing the timing
constraints relative to EXOSTIV IP.
VHDL Package file containing types used for
the EXOSTIV IP instantiation.
RX Transceivers synthesized IP
TX Transceivers synthesized IP

Add to Quartus project?
YES
YES
NO this is an example
template.
This file must be ‘sourced’ in
the project QSF file:
source <file path>/<Instance
name>_pinout.tcl
YES
YES
YES
YES

Table 4 : EXOSTIV for Intel – files generated in RTL flow

EXOSTIV IP Cache
The ‘EXOSTIV IP Cache’ functionality is available both from the ‘Insert EXOSTIV IP’ page in Netlist flow, and from
the ‘Generate EXOSTIV IP’ in RTL flow. The EXOSTIV IP Cache controls are accessible from the ‘Manage Cache’
button on these pages.
Using the EXOSTIV IP Cache is optional: the ‘Use IP Cache’ option must be selected to enable it.
The EXOSTIV IP Cache enables reusing previously generated EXOSTIV IPs and previously generated memories (RAMs)
to skip the EXOSTIV IP synthesis or the EXOSTIV IP memories synthesis.
Using the cache may greatly speed up the process of inserting the EXOSTIV IP, especially when using an incremental
debug process.
The button ‘Manage Cache’ available from the ‘Insert EXOSTIV IP’ window of the Core Inserter opens a window used
to view and delete the contents of the cache.
The cache contents are sorted by:
1. Version of FPGA vendor tool software (Vivado, Quartus).
2. Target FPGA type
3. Version of EXOSTIV Dashboard software
It contains:
1.
2.
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Synthesized EXOSTIV IP identified with their UUID.
The RAMs used with the IP

32

Information about the selection

Deletes the selected element
Deletes the whole IP cache
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Chapter 2: Analyzer
Requirements for using the EXOSTIV Dashboard Analyzer
The EXOSTIV Dashboard ‘Analyzer’ is the interface used to capture and analyze data from a running FPGA.
The Analyzer window is configured to match the objects and settings defined with the EXOSTIV IP. These settings are
included in the ‘EXOSTIV Dashboard project file’ (.epf).
Each EXOSTIV IP generated with the EXOSTIV Dashboard has got a unique identification number. This ID is used when
connecting the EXOSTIV Probe to the target FPGA to check if the project that is loaded in the EXOSTIV Dashboard software
corresponds to the EXOSTIV IP loaded in the target FPGA.
Hence, here are the cases when EXOSTIV Dashboard Analyzer will not be usable:
There is no ‘project’ defined: in such a case, there is EXOSTIV IP defined and hence, the probe cannot be connected
to the target FPGA. EXOSTIV Dashboard Analyzer does not have any valid setting about the capture units and data sets
of the target design.
-

The EXOSTIV IP core has not been synthesized nor implemented in the target FPGA: in such a case, there may exist
some projects settings, but there is no implementation of the target design instrumented with the EXOSTIV IP. EXOSTIV
Probe won’t be able to connect.

-

The project settings have been modified but the EXOSTIV IP core has not been synthesized or there is no
implementation of the newly instrumented target FPGA: in such a case, the project does not match the settings of
the IP core that is loaded in the FPGA (if any). EXOSTIV Probe won’t be able to connect.

➔ Check Chapter 1: Core Inserter to know how to synthesize EXOSTIV IP and implement the
instrumented design.
-

The project that’s loaded in EXOSTIV Dashboard does not match the EXOSTIV IP loaded in the target FPGA: in such
a case, the projects settings do not match the IP settings and the Probe won’t connect. Therefore, the Analyzer
won’t be usable.
➔

Please load the target FPGA with the configuration file that corresponds to the active
project in EXOSTIV Dashboard.

Rev. 1.0.13- June 29, 2021

34

Analyzer – Overview

EXOSTIV Dashboard Analyzer provides controls grouped by capture unit. In the Analyzer, each Capture Unit has got its own
‘tab’.
A capture unit is a functional entity inserted in the EXOSTIV IP that connects to up to 16 multiplexed ‘data groups’.
Each data group can count up to 2,048 connections to logic nodes of the target FPGA.
Each capture unit contains logic for defining trigger conditions and – optionally – data qualification conditions. It also
contains a memory buffer used as a FIFO.
The figure below shows a general view on EXOSTIV IP. The colored area shows what is controlled from the Dashboard
Analyzer at runtime. The other parts are used automatically by the Dashboard software and the probe to change the IP
settings and access the captured data at run-time. For detailed information about EXOSTIV IP, please refer to UG401 –
EXOSTIV IP.
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Capturing data – overview

Typically, capturing data involves defining the following:
A ‘trigger’ condition, which is used to detect a logic condition based on the connected FPGA nodes, which defines
when data must be recorded;
A ‘Samples per capture’ value, which defines the number of samples to be recorded once a trigger condition is
detected.
A ‘trigger position’ in the capture: it defines the position of the trigger condition in the ‘Capture’.
A ‘Number of Captures’, which defines the number of such trigger conditions that must be detected to end the capture
process. A ‘capture’ ends once it has recorded the required number of samples. Then the capture unit waits until the
trigger condition is met again and records a new capture. The process repeats until the specified number of captures
is collected.
Optionally, a ‘data qualification’ condition can be defined to filter the captured data. This condition is built as a logic
condition on the target FPGA signals connected to the selected capture unit.

Capture Unit Selection - Tab organization.
Each capture unit can be controlled from its own tab. Click on the capture unit tab that you want to control and use.

Each tab provides the following controls, for one single capture unit.
-

-

Data Group Selection: defines the data group to be observed from the selected capture unit.
Capture Control: defines the way data is captured, the number of samples to capture, the trigger position in the
capture and provides status about a running capture. This area also contains the ‘START/STOP’ buttons used to control
a capture and the controls for automatically exporting the waves.
Trigger and Data Qualification: this whole area is used to define trigger and data qualification conditions for the
capture.
Waveform Viewer: each capture unit tab includes its own waveform viewer to visualize, format and export the
captured data.
The settings for one single capture unit are defined from the corresponding tab. To capture data from more than one
capture unit, please check ‘Multiple Capture Control‘ below.

Data Group Selection
Each Capture Unit can be connected to up to 16 data groups. The Data Group Selection drop-down list shows the
data groups as defined in the project when setting up EXOSTIV IP with the Dashboard Core Inserter (please refer to
Chapter 1: Core Inserter).
This control changes the settings of the IP in the target FPGA so data from the selected data group of the selected
capture unit can be captured. The selection can be done for each capture unit.
In RTL flow, the ‘Data Group Selection’ area features an additional button ‘Edit Probes’ (see picture below).
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Edit Probes button: allows remapping the names of data probes
Clicking on this button opens the ‘Data Probes Remapping’ window (see below).

Capture unit selection tabs

Data Groups connected to
the selected capture unit
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Formally, the EXOSTIV IP created with the RTL flow is a generic IP with generic ports called ‘cui_Trig[range]’ for
data/trig ports and or cuj_Data[range] for data only ports. When using EXOSTIV Analyzer, it is desirable to rename or
regroup these inputs to ease the interpretation of the waves.
This window provides the following functionalities:
•
Data Probes renaming
•
Data Probes regrouping into bus
•
Bus splitting
To rename data probe: double-click on the chose probe in the ‘name’ column. The name can then be edited.

To regroup multiple probes into a bus: Hold SHIFT or CTRL and select the probes to regroup by click on them, then
click on ‘Make Bus’ button or right-click to open the contextual menu, and click on ‘Make Bus’.

To split an existing bus while keeping its name: select the bus and click on ‘Split Bus’ – or select the bus, right click
and select ‘Split Bus’ from the contextual menu.
To restore probes to their original names and grouping: select them and click on ‘Restore’ – or select them, right
click and select ‘Restore’ from the contextual menu.
The changes are reflected into the waveform window at the next capture. Hence, it is preferable to first define the
probe names and grouping, and then proceed with capture.
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Capture Control

Table 5 : Capture Controls
Control

Possible values

Run with trigger

(clickable button)

Run immediately

(clickable button)

Stop

(clickable button – appears in
blue when available)

Connect Probe

(clickable button)

Effect / Action

Runs the capture taking all the defined settings
into account: transfer mode, number of captures,
samples per capture, trigger position, trigger &
data qualification conditions.
Runs a single capture of the length defined by the
‘samples per captures’.
The trigger and data qualification settings are
ignored.
Stops (interrupts) a running capture. When
stopped, the data that has been already captured
are uploaded and displayed for processing.
Attempts to detect and connect to an EXOSTIV
Probe present on the USB port of the workstation.

Data
Transfer mode

Rev. 1.0.13- June 29, 2021

Burst to Probe

In this mode, data is transferred by bursts whose
size do not exceed the size of the FIFO
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Control

Possible values

Stream to Probe

Number of captures

1 to a maximum as defined in
Table 6

Samples per capture (top
control – drop down list)

Samples
per
(bottom control)

capture

32 to the capture unit’s FIFO
length by steps of power of 2.

Capture unit’s FIFO length to
a maximum defined in Table
6, by steps of 512 (auto
rounded to closest upper
value).

Effect / Action

implemented in the capture unit. This mode does
not involve ‘streaming’ data to the EXOSTIV Probe.
Single or multiple burst can be sent.
In this mode, data is transferred by bursts whose
size is bigger than the size of the FIFO
implemented in the capture unit. This mode
involves ‘streaming’ data over the transceivers.
Hence, it is may generate ‘overflows’ if the
bandwidth required to stream the data exceeds
what’s available on the gigabit transceievrs.
Defines the number of captures of size defined by
the ‘Samples per capture’. The range next to the
control helps compute the possible values.
This range is based on the total memory available
in the probe, the transfer mode and the number
of defined capture units and the number of
samples per capture. Please refer to Table 6 to
know how to compute this range.
Defines the size of each capture in ‘Burst to Probe’
mode. The range next to the control helps
compute the possible values.
Please refer to Table 6 for more information about
how to compute this range.
Defines the size of each capture in ‘Streaming to
Probe’ mode. The range next to the control helps
compute the possible values.
Please refer to Table 6 for more information about
how to compute this range.

Trigger
Trigger position

2 to Samples per capture-2

Defines the position of the trigger in each capture.
The value specifies a sample number.

Status : progress bars with the number of captures and the collected samples in the running capture.
Auto-export captures: use these controls to export data automatically when it is collected.
Enable auto export
Disable wave viewer

Enabled / Disabled

Output folder
File name
File handling
File format
Radix
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Overwrite or
Add timestamp
Binary or
Comma Separated value
Binary, Hexadecimal or
Unsigned decimal integer

Select to enable auto export of the data to a file
Select if you do not want to encode the captured
data in the waveform viewer format. In such a
case, data won’t be displayed in the waveform
viewer.
Use to specify the output folder where files should
be exported.
Use to specify the exported file name.
Defines the desired behavior when exporting the
data to files.
Defines the file format: binary (header + binary
data) or CSV file.
Defines the number format for the exported data.
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The Capture Control ranges and values are defined according to the relation below.
Table 6 : Capture Units ranges

NCap x SamplesCap x CUWidth ≤ ProbeMem / NCU
NCap

Number of
captures

Defines the number of ‘captures’. A ‘capture’ is a number of samples recorded
from the selected data group and under the conditions defined with the trigger
and the data qualification (see at this paragraph). The size of the capture is defined
with the ‘Samples per captures’.
The trigger condition defines the condition for starting a capture. The trigger
position defines where the trigger is located in the capture. The total number of
recorded samples is defined by the ‘Samples per capture’ (SamplesCap) value.

SamplesCap

Samples per
capture

EXOSTIV attempts to collect the specified number of ‘captures’. Once a single
capture is over, it waits until the trigger condition is met again, records a new
‘capture’ until the total number of captures is collected.
Defines the number of ‘samples’ to be recorded from the selected data groups for
each capture.
The width of a sample is defined by the largest data set connected to the capture
unit.
In ‘Burst to Probe’ mode, this number is based on the capture unit’s FIFO size in
the IP. The minimum is 32 and the maximum is the FIFO size. The value is defined
as a power of 2.

CUWidth

Capture unit
width

ProbeMem

Probe
memory
Number of
Capture
Units

NCU

In ‘Stream to Probe’ mode, this number is based on the probe memory (data is
streamed to the probe). The minimum is the size of the capture unit’s FIFO. The
maximum depends on the probe memory allocated to the capture unit (1/ NCU).
Width in bits of the capture unit. This value is defined by the widest data group
connected to this capture unit. The width of a data group is the number of bits
(FPGA nodes) it is connected to.
Total memory in EXOSTIV Probe = 8 Gigabyte.
Total number of capture units implemented in the EXOSTIV IP. This value ranges
from 1 to 16.
Other useful values

FIFO
Memory
per capture
unit
Probe
memory
allocation
per capture
unit
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1,024
CUWidth

8 GB / NCU

x

8,192 x CUWidth

Defined by steps of 1,024 words.

8 GB / NCU

The probe memory is divided equally among the capture
units.

41

Trigger & Data Qualification
Trigger & Data Qualification: overview
The trigger & data qualification controls are split into 2 areas, as described in the figure below.

AND and OR
Conditions
controls

-

Conditions
combination

The trigger and the data qualification conditions are based on the definition of the following:
One AND equation: it specifies a set of conditions on the capture unit’s signals combined as a logic AND.
One OR equation: it specifies a set of conditions on the capture unit’s signals combined as a logic OR.
Each equation can use a combination of conditions local to the selected capture unit and the result of the trigger or
data qualification from another capture unit.
The AND and the OR equations described above are combined to form the trigger or the data qualification unit. This
combination is defined with the right-hand, as a graphical combination. Please refer to the figure below for an
overview of the available paths.
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Defining Trigger & Data Qualification: usage and rules
Suppose you’d like to modify the AND Equation of the trigger. Please proceed as follows:

1.

To add a condition to the list, click on the ‘+’ sign at the top. This opens a window called ‘Trigger Signals’.

In this window you can find the list of the signals still available to add a condition to the AND equation.
This list is composed of the signals from the selected data group connected to the selected capture unit, that
are not already used in either the AND or the OR equation. So each signal that is marked as ‘trigger’ during
core insertion (please refer to Core Inserter – Capture Configuration) can be used once in the equations
defining the triggers.
2.

Select the desired signals and click on ‘Add Selected’. Or ‘Add All’. Then, click on ‘Done’. The added signals
disappear from the list.

3.
4.

The AND equation window is completed with the signals we have added:
Each of the lines in the Equation window is formatted as follows:

Enable or disable condition
Rev. 1.0.13- June 29, 2021

Signal name

Operator

Value

Radix
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Control
Enable / Disable condition
Operator

Description
Select to enable condition. Unselect to disable condition.
Drop-down list with the available operators:
Always available:
== : equality
!= : inequality
Only available if Levels/Edges/Comparisons was chosen as an option for ‘Trigger unit type’
at Core Insertion (refer to Core Inserter – Capture Configuration)
> : greater than
< : smaller than
>= : greater or equal to
<= : smaller or equal to
[…] : in range
![…] : out of range

Value

Value for combination. Right-click on the fields shows some of the options at bit level.
Bit level (binary) possible values:
X : don’ care
0 : logic 0
1 : logic 1
R : rising edge
F : falling edge
B: any edge
N : no edge
Hexadecimal or Decimal values can also be entered if the corresponding radix is chosen (see
below).

Radix

Radix for ‘Value’. Right-click to open the menu to change this:

bin : Binary
dec: Decimal
hex: Hexadecimal

Rev. 1.0.13- June 29, 2021

44

Cross-capture unit trigger
By default, it is possible to use the result of a trigger condition from one capture unit as a source trigger condition for
another capture unit. Because capture units are not always located in the same clock domain, some options are
available.
At the bottom of each (AND or OR) equation window, locate the following control ‘Use other capture units’. Select
tick box to enable it.

Click on the ‘pencil icon’ to edit the options:
A window opens, with the list of the available capture units (different from the active CU):

Enable / Disable usage of this capture unit’s trigger condition
Optional inverter on the capture unit’s trigger condition

Select if the capture units share a common clock.

Click on ‘Done’ once set up.
The ‘label icon’ allows defining a custom logic name for the condition.
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Remark about cross-capture unit triggering with multiple clock domains:
When the same sampling clock is used for the capture units, the event sent from the source capture unit to the
destination CU is fully synchronous and the detection thereof is immediate. In such a case, it is advised to select
the option ‘Common clock’ so everything remains synchronous.
When the source and destination capture units do not use the same clock the source trigger event is latched
into the destination capture unit. Once the event is seen at the output of the latch, the latch is reset. It is
important to note that there will be an undefined time between the generation of the source event and its
detection at the destination capture unit.

Waveform viewer (MYRIADTM)

Features – Overview:
-

Dock/Undock window (double-click in title);
Gigabyte-capable waveform viewer;
Wave database save / export (CSV, binary, VCD);
Waves formatting (color, size) – Analog or digital display – binary, hexadecimal, unsigned;
Formatting save / recall;
Flexible and fast zoom, even on very large databases;
Multi-marker;
Event and value search;
Multi-burst display (background color change)
Burst numbering / special trigger display
Multi-scale sample count (absolute or within each burst).

Multiple Capture Control
The optionally removable pane of the left-hand side of the Analyzer window provides the controls for running
captures from multiple capture units.
The capture settings must be defined for each capture unit separately.
Select the tick box corresponding to the desired Capture Units and use the run with trigger or run controls.
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Status bar

The Status bar returns the connection status of:
the chosen project flow (‘Netlist’ or ‘RTL’).
the connection between Vivado and EXOSTIV Dashboard if the netlist flow is used.
the EXOSTIV Probe with the PC (‘EXOSTIV Probe’).
the EXOSTIV Probe with EXOSTIV IP (‘FPGA link’). When properly connected, the red ‘X’ turns to a green ‘V’.
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Appendix A – EXOSTIV Dashboard Installation Notes
Installing EXOSTIV Dashboard – Windows 32/64 bit
1)
2)

Download the latest version of EXOSTIV Dashboard: go to: www.exostivlabs.com/download
Pick the desired version and register to request the download.
Unpack the program to start installation. Follow the installation process.
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Installing the EXOSTIV Probe USB driver
The EXOSTIV probe requires a USB driver to be installed:
1) Connect the EXOSTIV Probe to the PC with the USB cable and power it on.
2) If not automatically prompted to install a driver, start Windows’ Device Manager and locate the EXOSTIV
Probe in the list:
Right-click on ‘EXOSTIV Probe’ and select ‘Update Driver Software…’
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Select ‘Browse my computer for driver software’ and specify the right location of the driver.
For 32 bits windows, the default directory is C:\Program Files\Exostiv Labs\EXOSTIVDashboard\drivers\x86
For 64 bits windows, the default directory is C:\Program Files (x86)\Exostiv Labs\EXOSTIVDashboard\drivers\x64

Installing the EXOSTIV Dashboard button in Vivado
(Applies to EXOSTIV for Xilinx only)
EXOSTIV for Xilinx provides a ‘netlist flow’, that enables EXOSTIV IP insertion after synthesis. This flow requires linking
EXOSTIV Dashboard to Vivado using a shortcut to a script in Vivado’s toolbar.
This shortcut is automatically added at the end of the EXOSTIV Dashboard software installation.
In cases where the installation program fails to locate the Vivado installation properly, it is possible that no button
gets inserted in the Vivado toolbar.
Please check your Vivado toolbar. If the EXOSTIV icon is NOT visible, then you have to install it manually:

To install the EXOSTIV Dashboard shortcut into Vivado, please use one of the following procedures:

Procedure #1 – Through EXOSTIV Dashboard menu (semi-automatic).
1.
2.
3.

Close Vivado.
Start EXOSTIV Dashboard
Click on the following menu item: Tools > Install Dashboard Shortcut
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4.

You should receive the message: ‘Integration with Vivado succeeded’.

Procedure #2 – Setting it up from Vivado
1.
2.

Start Vivado
Click on the following meny item: Tools > Customize Commands > Customize commands…

3.

Hit on the green ‘+’ button on the upper left corner:

4. Type ‘EXOSTIV Dashboard’ in the dialog that opens. Press ENTER.
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5.
-

Enter the following lines in the main dialog window:
Run command: source "C:/Program Files (x86)/Exostiv Labs/EXOSTIVDashboard/vivado_server.tcl" -notrace
Select ‘Add to the toolbar’
Optionally add the following tooltip: Start EXOSTIV Dashboard
Icon file path: C:/Program Files (x86)/Exostiv Labs/EXOSTIVDashboard/Exostiv-icon_32x32.png

Please replace ‘C:/Program Files (x86)/Exostiv Labs/EXOSTIVDashboard’ with the alternate path that you used for
installing the EXOSTIV Dashboard software.
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Installing EXOSTIV Dashboard – Linux
1.

Please refer to:
EXOSTIV Dashboard for Xilinx – Technical specifications
EXOSTIV Dashboard for Intel – Technical specifications

to check the supported Linux distributions and versions.
2.

3.

Download the latest version of EXOSTIV Dashboard: go to: http://www.exostivlabs.com/support/downloads/
Pick the desired version and register to request the download.
Make the installer executable

In the window manager, right-click on the installer. Select the “Permissions” tab and enable the “Allow executing file
as program” checkbox.

4. Run the installer
Double click on the installer to start the software installation. Click three times on “Forward”, then on “Finish”.
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At the end of the installation, two new icons appear on the desktop to start and uninstall the application.
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Before running the application
EXOSTIV Dashboard requires libusb-1.0-0 to access the probe. Type following command to install libusb:
sudo apt-get install libusb-1.0-0
Enter the administrator password to complete the installation.
Libusb requires administrator privilege to use the USB bus. To remove this limitation, proceed as follows:
Open file “/lib/udev/rules.d/50-udev-default.rules” in a test editor like gedit with administrator
rights.
Search for the following line in the file:
SUBSYSTEM=="usb", ENV{DEVTYPE}=="usb_device", MODE="0664"
Replace with this line:
SUBSYSTEM=="usb", ENV{DEVTYPE}=="usb_device", MODE="0666"
Save the file.

Integration with Vivado
Linking EXOSTIV Dashboard to Vivado for Core Insertion requires using a shortcut to a script in Vivado’s toolbar.
In Vivado, open the “Customize Commands…” dialog with Tools > Customize Commands > Customize Commands…

Click on the

sign and enter “EXOSTIV Dashboard” as menu name and press Enter.

Complete the fields on the right side as follows:
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•
•

Run command : source "/home/<user>/<EXOSTIV installation directory>/vivado_server.tcl" -notrace
Icon file path : /home/<user>/<EXOSTIV installation directory>/Exostiv-icon.png

Replace <user> with the user name. Or adapt the path according to the installation folder. Click on “OK” to validate the changes and
close the dialog box.
The newly created custom command should now appear in the menu.

A new button will appear in the toolbar.

The new menu entry and the new button can now be used to start EXOSTIV Dashboard.

Using the application from a command prompt
The EXOSTIV Dashboard can be started from a command prompt. First go the install folder, typically “cd ./EXOSTIV-1.5.4” and execute
command “./ExostivDashboard.sh”.

6.
-

Enter the following lines in the main dialog window:
Run command: source "C:/Program Files (x86)/Exostiv Labs/EXOSTIVDashboard/vivado_server.tcl" -notrace
Select ‘Add to the toolbar’
Optionally add the following tooltip: Start EXOSTIV Dashboard
Icon file path: C:/Program Files (x86)/Exostiv Labs/EXOSTIVDashboard/Exostiv-icon_32x32.png

Please replace ‘C:/Program Files (x86)/Exostiv Labs/EXOSTIVDashboard’ with the alternate path that you used for
installing the EXOSTIV Dashboard software.
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Appendix B – Using ‘Design Checkpoints’ (DCP) flow type
(This section applies to EXOSTIV for Xilinx)

Using Vivado with and without project files (.xpr)
Xilinx Vivado provides several ways to define and implement FPGAs.
The default usage of EXOSTIV implies defining ‘projects’ files in Vivado (.xpr).
However, in some cases, project files are not used – especially when the target FPGA design is not synthesized with
Vivado, but with a third-party EDA synthesis tool.
A very common way of using Vivado is to proceed by successively saving ‘Design Checkpoints’ (.DCP). Such checkpoints
allow saving the state of the implemented design at any point of the flow. By using checkpoints, it is not mandatory
to use project files (.xpr). The set of commands that can be used in Vivado differ on whether a project file is used or
not.
In this section, we present an alternate flow for using Vivado and EXOSTIV Dashboard without Vivado .xpr project file.

Flow
-

We suppose that Vivado is used with the target FPGA design after synthesis. The synthesized design is loaded into
Vivado as a netlist. Hence, the starting point is a design checkpoint (.DCP) saved with Vivado after loading the target
FPGA design. We suppose that no Vivado project is defined.

-

In the EXOSTIV Dashboard, calling the implementation run is based on the preexistence of a Vivado project file. For
this reason, the implementation of the FPGA design instrumented with the EXOSTIV IP cannot be started from EXOSTIV
Dashboard. Hence, the option of starting the implementation from the EXOSTIV Dashboard must be de-selected.
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-

After loading the synthesized design into Vivado (possibly recalling the corresponding design checkpoint), the
EXOSTIV Dashboard can be linked to Vivado with the usual flow (please refer to section starting from ‘Core
Inserter - Overview’).
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-

Pressing the ‘Insert EXOSTIV IP’ button from the Insert EXOSTIV IP window of the Core Inserter will start and run
the flow up the the ‘Design Rules Check’. Thereafter, the result is an ‘instrumented synthesized design’, that is,
the same original design netlist, where a synthesized EXOSTIV IP is inserted and connected to the nodes chosen
with the EXOSTIV Core Inserter.

-

Save your EXOSTIV Dashboard project file.
From there, the implementation of this ‘instrumented design’ must be manually started. Here is how:
1. Switch to the Vivado session where the synthesized design had been loaded originally. The unit ‘exi_top’
(EXOSTIV IP top) should be present in the design.
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2.

Successively use the following commands from the Vivado command line interface:
Opt_design
(optionally: power_opt_design)
Place_design
(optionally: phys_opt_design)
Route_design
Write_bitstream <file name>

Please refer to Vivado command line / batch mode user’s guide for additional details and options.
3.

You can then load the FPGA configuration and use EXOSTIV Analyzer.
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